


Preface

This is the Slim Edition of Cruising the Canyon!

Most of the background renders and filler has been removed to produce a
smoother file that takes up less space. While some pages still look similar,
most of them have been made empty as to optimize them. If you’d like to
read the full version, go to sr64dd.github.io and download the Revisied
Edition. Do note that you are not missing any content by reading this
version, only a few background renders. In addition the Wisdom and
Applications section is completely intact.

If this version is still running poorly on your computer and you wish to just
learn about the Bryce interface, consider downloading the Survivalist
Edition. It contains all of the section Functions and part of the section
Wisdom, as well as cutting out all of the fluff.

Thank you for reading!
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To quickly skip to a certain section, refer to the contents below. The numbers in italics are
the page number of important or useful functions.
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Beginning

Imagine this.

An infinite azure, an oasis of nothingness, a void filled with
water. Then, a torus, resting in the water, covered in chrome
with a blinding shine. Then, towering stone pillars covered in
blue moss rise out of the water, looking down on the poor,
cowering torus. Suddenly, the sky changes mood, becoming
a much harsher blue, painting the water in its image. Finally,
as the scene moves around, a mountain made of lapis lazuli
makes its presence known, and firmly finishes your scene.

Chances are, you just thought of an image like the one on the
right. While it isn’t the most flattering sight, it captures a sort
of essence of an age passed on. The scene was made with
older technology. If it was made with newer technology, it
might have looked fancier, but that retro charm would’ve
disappeared.
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The Essence

That’s it! That’s the beauty of Bryce! That retro aesthetic, not
too bad to be an eyesore, but not good enough to make
disarray in a scene stand out or seem random. Try imagining the
scene as hyper-realistic as possible, as if it was rendered by a
modern 3D rendering software.

You’ll notice that the rough primitive style of the Bryce render
lends itself better to the concept than a rendition that aims to be
more realistic. Of course you can emulate a retro look with each
of those programs, but Bryce comes pre-packaged with this
stylized aesthetic. No nodes, no shaders, just bliss.
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Where to Begin
If you are completely new to Bryce and 3D rendering, stop reading this now! I know that sounds counter-intuitive, but right
now you are full of creative urge and freedom. You don’t know any rules so you don’t need to abide by any rules. So open
Bryce and start placing stuff as you feel. Water here, Mountain there, maybe a starry night sky? Who cares! All that matters is
that you are creating something. Trust me, you’ll miss the creative rampage your brain will go on when it’s first given the tools
to do as it pleases, speaking from experience.

If you aren’t new to 3D rendering or Bryce (or don’t care for what I have to say) then continue reading! Maybe keep Bryce
open so you can fiddle with the functions of the program as you read about it. Next up is a comprehensive list of what Bryce
has to offer, but don’t feel obligated to read it all! Pages with a next to the header are about tricky, complex, or otherwise
useful features, everything else is somewhat self explanatory or can be understood just by fiddling around.
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Observe, the quest to create something on
the left, and the quest to create something

“good” on the right.

Limitations breed creativity, but so does
ignorance. Don’t waste the moment!



The Basics

When opening Bryce 7 you’ll be
greeted by this editor. If you are
using Bryce 3, then this screen
will be in the middle of a
completely black background.

Everything is organized into
sections with related elements.
The left side is all camera
controls. The top changes
between objects, materials, and
sky settings. The bottom changes
between animation and selection,
and the right is all for special tools
that don’t affect rendering.

The scene view in the middle is
the viewport.
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Object Overview
To understand what each action and shortcut does, it’s helpful to know the main elements on an object. For now, the
most important properties are the type, the material, and the position, rotation, scale, and origin (collectively a matrix).
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This object is a sphere.
This is important for
selecting all objects of a
type.

This object has a matrix
(X Y and Z for Position,
Rotation, Scale, Origin)

This object has a material
made up of textures,
which are made up of
components. Those last
two become important
later.



Create Tab

The first tab above the viewport is the Create Tab. This is where you’ll be adding objects, ranging from maths-based
primitives to light sources to flat planes and procedural meshes. The logo on the right sends your scene to DAZ Studio. The
objects with yellow and green on them are restricted to Bryce 7 Pro and are not in Bryce 3.
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Clicking the arrow next to the Create Tab will bring up a menu full of preset objects, including more primitive shapes,
boolean shapes (shapes with other shapes cutting into them), editable trees (more on that in the Tree section), objects
exclusive to Bryce 7 Pro, some more primitives, household models, weird swirls, planets, animation paths, rocks, more
trees, mountains, even more trees, objects featured in some Bryce tutorials (all beach themed), and various shrubs and
flowers.



Infinite Planes and Volumes
Infinite planes are objects that appear as planes on the viewport, but appear infinitely large when rendered. There are three
types of infinite planes; Water, Cloud, and Ground. As far as I’m aware, the only difference between them is what material
they are created with, where they are created, and their starting scale. To prove it, I rendered all three using the sky “Peach
Haze” and the material “Mermaid’s Hair.” They’re basically identical, but the ground plane material was rotated slightly.
Labelling them isn’t even necessary!

Oh, and the reason why there are only 2 renders is because the Water and Cloud renders were exactly the same.
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Usually, an infinite plane works fine, but if you want more depth (say you are making a sky with
clouds, and don’t want to use a flat plane or the sky lab), you can use a volumetric slab! Hold
one of the three plane objects on the create tab, and you should see a menu asking for either a
Surface or a Volume. Release on Volume and a cuboid should appear. The top background
image is a volumetric slab. It looks almost like the moon’s surface, but results can vary based
on material. Some just look... funky.

Despite the slab being infinite, both the width and depths can affect the slab
in meaningful ways. Some materials may take a while to render, especially

those in Misc > Volumetrics!



Terrains and Symmetrical Lattices
Bryce is known for its superb fractal terrain abilities. That’s why the program is called Bryce. It’s in reference to the
Bryce Canyon in Utah!

Terrains and Symmetrical Lattices are randomly generated, so each time you click create either you’ll get a brand new
mountain or lattice. This is useful for making backdrops for a scene, however on their own they’re pretty bare bones.
This is where the Terrain Editor comes in. When selecting a terrain or lattice, click the [E] button (Edit) that appears
beside it, below the [M] button (Material Lab) and above the [↓] button (Landing). This should bring you to the terrain
editor. In this editor, you can paint the height of the mountain, apply various effect and edits to the canvas, and even
animate it. Some of the Editing Tools are both clickable and draggable.
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Nooks of the Terrain Editor
In the Terrain Editor you can edit the height map of the terrain
by either drawing on the height map, applying effects, or
importing an image.

The buttons next to Terrain Canvas (the two squares and
down arrow) let you make the terrain solid underneath,
change where the terrain becomes hollow (the red zone), and
change the appearance of the terrain in the editor.

The Filtering Tab lets you adjust the height of pixels based on
a graph. The Pictures tab lets you import your own height
maps, even if they aren’t black and white.

The Brush circle lets you change the area that you apply
strokes on the Terrain Canvas. The grid of squares lets you
change the resolution of the canvas, which can be good for
getting huge details or smoothing out a terrain.

Try experimenting with the different effects!
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Trees and Rocks
Bryce has two other native “natural objects,” being the rock and the
tree. Rocks act like any other imported mesh. They have an edit menu
and various presets can be found in the Create Tab.

Trees on the other hand are much more special. They have their own
Tree Editor accessible by clicking on the edit [E] button while the tree
is selected. In the Tree Editor you can modify the trunk, leaves, and
style of tree. There are also preset slots if you want to save certain
configurations.

Trees also have some presets in the Create Tab (in Bryce Trees,
Special Trees and Trees are just regular meshes and uneditable).
Additionally, if you hold Alt while adding a tree you’ll have access to
several other presets.
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Metaballs

Metaballs are spherical objects that, when put close enough
to another metaball, will attract towards it and join up. They
kind of function like droplets, joining together to form one big
mass but only if they’re close enough.

When two metaballs with different materials connect, the
material will slowly transition from one to the other. The
blending isn’t always too accurate but it can lead to some
cool transitions.

Additionally, metaballs can be either positive or negative but
not neutral or intersect. Negative metaballs will warp other
metaballs around the area it would have occupied. Negative
metaballs can still have their material appear on the main
mass.

While metaballs seem very powerful, they are also prone to
crashing Bryce. Whether they crash or not seems
independent from how many are in the scene, so remember
to save your scene when using them.
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Primitives
Spheres, Toruses, Cylinders, Cubes, Pyramids, Cones, Disks, and Faces are all primitives. They are mathematically
generated objects that are uneditable, except for the Torus which lets you modify its thickness.

In Bryce 3, each primitive is listed with 3 more options of varying scale. These can still be accessed in Bryce 7 Pro by
holding Ctrl or Shift while adding one to your scene. Doing this for the Disk and Face will orient them facing the sky.

Along with the primitives is the 2D Picture Object, a flat plane similar to the Disk and Face. When you create one you’ll
be prompted to select an image, and then the object will be created. This scales the object in a way so that the image
doesn’t appear stretched or squished, making it ideal for importing images over putting them on a Face. This works
with transparent images too.
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Lights
Dang it! The lights on these pages are busted! Well, we can just do what we did last time: make our own!

Bryce 7 has five primary light objects: Radial, Spotlight, Round Parallel, Square Spotlight, and Square Parallel (Bryce 3 has all
of these except the Square Parallel). These illuminate the objects around it in various ways. Radial lights will brighten
everything around it, the Spotlights will shine on a specific area, and the Parallel lights are the same but for both sides.
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Luxury Bulbs
If you have Bryce 7 Pro, then you have access to seven more light sources: Distant, Round and Square Parallel, Sphere and
Cube Dome, and Sphere and Cube Fill. The additional Parallel lights are just updated optimized versions of the old lights.

Distant Light acts as a sun source, lighting up everything in the scene no matter its position. The Dome lights are similar to the
radial lights but are more dynamic and optimized, acting like ambient light from the sky and casting light into crevices. The Fill
lights also act like Dome lights but are more so intended to tweak the lighting in a scene, rather than act as the main light source.

Below is an example of the sphere dome light in a scene.
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Light Switch Configuring
All light sources can be edited via the Light Lab,
letting you change the colour and intensity, how the
light affects the scene, and various other options.

Gels let the projected light take the form of an image
or a material rather than a colour. The colour can also
be set to a changing gradient. The light can be
displayed as a visible object too.

Most options on the left are specific to certain light
objects. Cluster options relate to Dome and Fill lights
and control how light is projected in the scene.

All of the options here are also animatable, and you
can save light presets with the familiar save slots in
the bottom left.
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Importing 3D Models

Meshes are like primitives in that they can not be directly edited, though they are defined by
regular 3D conventions instead of maths. Rocks are a type of mesh, but you can import
your own via File > Import Object...

Bryce supports many different file formats including the usual OBJ, 3DS, FBX, and DAE.

When models are in scene, you can change how Bryce handles the faces, either rendering
them in a blocky way or in a smooth way.

6 The Basics

On the left, the model is rendered
unsmoothed. On the right, the
model is rendered smoothed with
the default settings.

Smoothing can be done by
clicking on the [E] button when
selecting a mesh.
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Edit Tab

While the Create Tab let you create objects for your scene, the Edit Tab is all about manipulating those objects. In order,
the Edit Tab lets you enter the Materials Lab, Scale, Rotate, Move, Align, and Randomly move objects, as well as Edit
Terrains or Objects with a [E] button present when selected.

Clicking the Arrow next to the Edit Tab will bring up a menu full of material presets organized into various categories and
subgroups. Unlike the Objects menu, the Materials menu has a wide variety of applicable presets, so you’ll become
accustomed to visiting it.
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The Big Three (Transforming, Rotating, Scaling)

There are multiple ways to move, rotate, and scale your objects. One way is via
the Edit Tab. Simply grab on one of the axis and drag to change the property.
The first of these controls changes scale, the one next to it rotation, and the
next transformation. The arrows at the bottom right of these controls can be
used to change which set of axis to use, and can also reset values. The scale
menu also lets you flip objects along certain axis.

Object Space moves, rotates, and scales objects according to their axis. In
short, you won’t get any warping and objects will always move in an
understandable direction-based fashion. World Space uses the axis of the
world. This can mean that objects don’t always move the way they are facing.
but every object transforms along the same axis. And Camera Space uses the
axis based on the current view.

Objects will rotate based on their origin handle. To view an object’s origin
handle, go into its attributes and turn on Show Origin Handle. This is more
important for animating objects.
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Viewport Manipulation

Objects can also undergo these actions directly from the viewport as well. To move something,
click the object on any part except the anchor points and drag. For movement on a single world
axis, drag and then hold Ctrl or Alt for the Z or Y axis. To scale, click and drag any anchor. Then,
hold Alt to scale from the centre, Ctrl to scale from the opposite side, or Shift to scale in
increments. To rotate, hold Ctrl before dragging an anchor. Corners let you rotate freely while
edges restrict rotation. Holding Shift rotates in increments and Alt rotates in fine amounts.

These key commands also change the controls in the Edit Tab too, though movement commands
become Shift for moving in increments and Alt for fine movements.
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Order and Chaos (Align and Randomize)

The two controls next to the reposition control are the Align and Randomize
controls.

The Align control will align all selected objects to a given axis, represented by
bars separated by three balls each. Each line corresponds to an axis, and
each ball corresponds to the front, centre, and back of the group. As an
example, pressing the Y Bottom button will bring all selected objects to the
bottom of the group, where the lowest object was. And pressing the All button
in the centre will bunch up the objects in the centre of the group.

The Align tool also lets you snap objects, available by clicking the arrow in the
bottom right of the control. This lets you snap objects to each other similar to
Aligning on All Axis, snapping to the grid, and landing objects on the world
floor (Snap to Ground) or the surface of the nearest object below (Snap to
Land).

The Random control randomizes the position, rotation, and scale of selected
objects. It can do this for either the X and Z axes or all three axes. First, click
the arrow in the bottom right to choose the randomisation method, then drag
the button in the top right to randomize!
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Material Editing

The first control in the Edit Tab takes you to the Materials Lab. This can also be done by selecting an object and
pressing the [M] button that appears next to them.
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Layer 1 — Materials Lab

Every material is made up of various properties and values.
The top six are primarily for the colours the material uses,
while the rest are for how they are displayed. These values
and colours can be constant values or variables taken from
the textures (the little blue balls next to each property).

Diffuse and Ambient control the main colour of the material.
Ambient and Ambience control what the unlit part of the
object looks like and how bright it should be.

Specularity is the shine an object has from light. Metallicity
controls a mixture of all Diffusion, Ambience, and
Specularity. Bump Height and Displacement control how the
object’s surface appears. Bump Height mimics an unlevel
surface while Displacement actually changes the objects
shape.

Transparency makes the material look like glass, and
Refraction changes how rays pass through it. Reflection
reflects rays back, creating a mirror effect.
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Texture Effects

Anisotropy changes how highlights and reflections are
rendered, making them slightly more distorted and angled.
This affects the specular shine. When plugging a material, this
can lead to unique results like the ones on the right.

For every property, plugging a material will do different things.
Diffusion, Ambience, Transparency, and Reflection all apply
only to areas dictated by their alpha map. Bump and
Displacement need a texture to define what areas to raise.
Specularity and Metallicity are all defined by values within the
texture.

Anisotropy on the right uses, in order, Basic Sin, foamywater, grid simple, and
stepp’N tile.
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Adding and Editing Textures

By pressing an empty texture slot next to a property you can add a texture. Each material
can have four textures, A through D, and their colour, alpha (where the texture is
transparent), and bump (where the texture looks bumpy if applied to the bump height
property) channels appear on the right.

The top right green button lets you scale, rotate, and transform the texture. The scale
control actually controls the frequency, so lower values will make the texture appear
bigger. The red button next to it will take you to the Deep Texture Editor. Pressing
anywhere else on the top will let you pick from texture presets. Shift clicking will bring up a
bigger menu to browse through.

The T and P buttons lets you change whether the texture slot is a texture or picture. If it is
set to picture, then the red button will take you to the Pictures menu.

The bottom right arrow changes how the texture is mapped to the object. World mappings
will scale and wrap the texture relative to the world, so that changing the size or rotating an
object won’t transform the texture. Object mappings scale and wrap with the object, so
scaling and rotating the object will scale and rotate the texture too. The other options are
for special cases regarding the shape of the object or the type of material.
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Extra Settings

In the top right corner is a small arrow which brings out more
configurable options.

The first four control how the material looks. Blend Transparency will
make transparent parts appear invisible instead of glassy. The rest are somewhat self
explanatory. The bottom options are all miscellaneous, such as Linear scaling which
controls whether textures are scaled regularly or in a nearest-neighbour non-blur way.

From the Materials Lab you can copy and paste materials, change settings about
the little view box in the top left, change the scale of textures with the four rods
in the top, and change materials quickly using the right-pointing arrow next to the
view box. You can generate a random material by pressing the blue sideways
button next to Specular Halo, and you can reset the material to the default grey
by pressing the red button next to Volume.
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Speaking of Volumes

By pressing the rock labelled Surface you can toggle the
material into a volume. Volumes have very similar
properties to Surfaces, but they also have some unique
ones.

Base Density pretty much controls the shape of the
volume and how much is present or filled. Edge Softness
and Fuzzy Factor control how soft or sharp the volume
looks. Quality/Speed controls how good the volume
looks vs how fast rendering it will take. It’s like a game of
tug-of-war between a fast render and a good material.

Volumes also have unique settings, such as different
shading modes.
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Layer 2 — Deep Texture Editor

By clicking the red button on a texture you can edit the
components that make up the texture in the Deep Texture
Editor. In short, Bryce uses various noise and combining
functions to generate textures.

Each component has three colour swatches and a drop-
down menu determining how the colours are interpreted.
Above the swatches is a button which resets the
component. The C, A, and B buttons control whether the
texture uses the Colour, Alpha, and/or Bump of the
component. The button below these letters randomizes the
component.

On the final combination, the red button lets you pick a
texture from the texture library, and the blue button
randomizes all three components.

The numbers in the left corner let you set the amount of
components and the objects in the other corner let you
change how the components are displayed in the editor.
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Noise, Phase, and Filter

The Noise is the actual shape of the component. It can be
defined by pressing the Noise button in the bottom or the top left
of any component, then by pressing the top-left of the noise pop-
up. Bryce has various types of noises and different modes too.
The octaves change how many recursions the noise does. Most
of the modes require an octave of at least 1. The dimensions and
frequency of noise can also be changed.

The Phase warps the noise according to another noise. It is
accessed with its button in the bottom or the bottom left of any
component, then the top left of the phase pop-up. Its menu is
identical to the noise menu.

The Filter affects how the colours are applied to the noise. It is
accessed with its button at the bottom or the top right of any
component. It has a function, swappable by clicking on it, and
variables influencing it, individually draggable or changed by
dragging on the graph graphic.
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Combining Components

The arrows between components control how the components layer on each other. Clicking on them allows you to change
blending modes. Most of them follow typical blending conventions like multiplying and adding, while others act based on the
orientation of the texture, and others fall off in various ways. Experiment with different combos, there’s pretty much an
infinite amount of combos when combined with noise, phase, and filter alterations!

In a similar manner, the mapping of colours can be changed using the menu below the swatches of any component. These
follow similar types as the combination methods, and many of them consider the values of the colours picked without
directly showing that colour. If you just want the colours you picked to appear with no exceptions, use Linear Interpol2 or 3.
Some other options like Randomized also preserve picked colours. And no matter what setting the colour is on, it will not
affect the alpha or bump of the component.
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Pictures!

If your texture slot is a picture, clicking the red button will take
you to the Pictures menu instead. Here you can add, delete,
rename, and select images. You can also save and load lists of
images.

The first box at the top shows your image with no alpha, so all of
the transparent parts appear opaque. The second box shows
just the alpha channel, and the third combines the two. The
black and white circles above the first box will replace your
image with a completely black or white version (as in fully one
colour, not monochrome).

The half-black-half-white button above the second box inverts
the alpha channel, so fully opaque areas become transparent
and vice versa.
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Nifty Replacing

The Edit Tab has one more feature in a control in the top right corner that looks like a two-way arrow. Holding it reveals an
array of objects, and releasing on one will replace all selected objects with it while still preserving size, rotation, position etc.
This can be useful for experimenting and creating chaos (like changing everything to metaballs) but it also has good practical
use. You can position objects directly on each other without copying their matrix. Changing a terrain or lattice to a different
object and then back will generate a new height map. Trees and rocks also get randomized like this, and each object
selected will become a unique tree or rock. However, Swapping between terrain and lattice will preserve the height map.
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Sky & Fog Tab

The Sky & Fog Tab lets you manipulate the sky and atmosphere of the scene. This includes the sun, sky, haze, fog, clouds,
celestial objects, ambient colour, shadows, and more. Although most of these settings are available in the Sky Lab, the most
common settings are also available directly in the tab. Clicking the arrow as usual will bring up various sky presets.
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The controls in the tab also let you randomize all settings using the button that looks like a line of dots. The sun icon to the right
of that toggles the sky between day and night. The cloud and rainbow symbol takes you to the Sky Lab. The tab also has the
usual preset slots, and the arrow below the slots lets you further customize the sky, changing how it is shaped and which
clouds are present, and rendering the scene every time an adjustment is made.



Common Sky Controls

These boxes control the most common sky properties. For all of them but the first and last, you drag left and right to change
the value and by clicking Alt on the square you can disable the feature. The image part of the control and the colour part of
the control can sometimes alter different things, so look at the bottom left corner as you hover over them to see what they
do.

The first box (Sky Mode) controls the colours of the sky. You can set it to be Soft, Dark, or Custom which lets you pick the
colour of the sun, sky, and horizon. You can also set the mode to Atmosphere Off which sets the sky as a solid colour and
disables the clouds, haze, fog, and the sun.

The other controls alter certain parts about the sky and environment, like shadows and clouds. The haze (the light part of the
sky on the horizon) can also be altered, as well as fog. All of these can be altered in the Sky Lab as well.

The blue and grey graph on the right controls the frequency and amplitude of the clouds. Drag left and right to change
frequency and up and down for amplitude.
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Sky Lab

More intricate settings are available in the Sky Lab. It has
individual sections for the Sun and Moon, Clouds,
Atmosphere (Haze, Fog, etc), and IBL (Image Based
Lighting).

The Sky Lab has a lot of unique settings like celestial
stars and comets, halo rings, rainbows, sky blending with
sun, and cloud movements. It also has more controls for
basic parts of the sky, like heights for the haze and fog,
or size of the sun.

You can also animate all of these properties.
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HDRIs

The IBL section is all about HDRI images. HDRIs are high
dynamic range images. You don’t need to know too much
about how they work, but note that you can make your own
HDRIs in Bryce via File > Export Image, or you can simply
find HDRIs online.

HDRIs change the way lighting works in your scene. They
generally give your scene more realistic lighting and
rendering effects similar to Premium Rendering. You can
further modify HDRIs in the IBL tab, and if you don’t like the
lighting you can use just the sky box.
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The background HDRI is Sunflowers (Pure Sky)
from Poly Haven.

https://polyhaven.com/a/sunflowers_puresky


Taming the Sun

The black and grey globe in the Sky & Fog Tab and the Sky
Lab controls where the sun is and where it shines on the
scene. The orientation of the control is based on World
Space, so having the sun perfectly in the centre will shine
light directly above objects, and having the sun near the
centre bottom will cast light along the Z Axis.

If you would rather pose your sun relative to the viewport,
hold Ctrl and Alt and double click on the sun control in the
Sky & Fog Tab, then hold Ctrl and Alt and click anywhere
on the scene. A little yellow or blue star should appear,
which is where the sun or moon should appear too.

The white square bottom left to the sun control is the
colour of the sun. Changing it will change the light shined
onto the scene and some parts of the sky. The sun control
will also change colour to match the current sun colour.
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Instancing and Replicating

The Edit option in the window toolbar has a few options relating to
Instancing and Replicating.

Replicating replicates your last move or addition in relation to your
current selection. This means if you place a sphere, move it, and
then replicate it, another sphere will appear in relation to the first.
Multi-Replicate and Random Replicate do the same thing, but
multiple times and with some variation.

Instancing creates a clone of the selected object. Unlike copying
or duplicating objects, instance clones will copy the attributes of
the original “master” object, and they can not be directly edited.
The Convert to Standalone option below the Instancing ones will
unlink the instance from the master.
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Instancing Lab

For more control in Instance creation you can use the Instancing
Lab, accessed by pressing the [I] button that appears when
selecting an object. The Instancing Lab lets you spread various
objects on the selected object and is highly customizable.

Within the Instancing Lab is the Brush Editor, which allows you
to change how instances will be created. This gives instances
some randomness and variety. It also lets you pick from a
collection of objects by selecting them in the Brush component
drop-down. These combined can make your instances seem
more natural and are good tools for decorating.

The Painter section lets you place instances, changing their
randomness, spread, density, and other settings. You can also
remove placed instances by using the eraser tool, and instances
can be added as stand-alone objects by Ctrl Clicking on the
canvas.
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Grouping Linking and Tracking

Bryce has three main ways to “attach” objects to each other. Grouping will create an object that holds each grouped object,
letting you move them as one and apply boolean transformations and convert the boolean to a single object mesh. They can
still be selected individually and edited as such. Some actions done on the group object will affect all child objects, like
changing material or showing the mesh as a box in the viewport. The group has its own matrix, so rotating it will swing the
objects around instead of rotating each one. Groups can also be part of bigger groups.

Linking lets you attach an object to another (not literally, more so spiritually). Transformations done to the parent object will be
applied to the child, but transforming the child wont affect the parent. You can use this relationship to produce interesting
results, such as transforming both objects at once and seeing transformations double, or creating a series of links to make a
rig (more on that in Wisdom!). In the attributes menu of the child you can change what the parent influences. A child object
can only have one parent, and child objects can not be part of groups.

Tracking lets you make an object “look” at another. It won’t move the child but it will rotate it based on the position of the
parent. In the attributes menu you can change which direction of the object should be looking. Linked parents can not track
their children.

Group objects by selecting them and clicking the [G] button. Link an object to another by clicking the [ ] button and dragging
it to another. Make an object track another by clicking the [ ] button and doing the same.
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Cutting Objects (Booleans)

Objects in Bryce can have different states that change how they interact with each other when grouped. They can be
Neutral, Positive, Negative, or Intersect. Negative objects cut out the part of the group they’re covering, and Intersect
objects only render the parts of the group intersecting with it. Both of these types interact with Positive objects, which are
the default visible type of objects. Positive objects are fully outlined in the editor, Negative objects have dotted outlines, and
Intersect objects have dashed outlines.

The other type of object is Neutral which is what every object is created as. Neutral objects do not change based on
negative or intersect objects and will always be fully visible. They also have regular outlines.

Below are representations on what different combos look like. The outlined segment is what would be rendered. Keep in
mind, Negative and Intersect objects appear normal if there is no Positive objects in the group.
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Selecting Multiple Objects

In the very bottom right corner you can toggle between the Time and Selection Palette. The Selection Palette has an array of
objects you can select, which will select every instance of that object in the scene. This list starts with Volumetric Slabs and
ends with Families. Everything else in between is referring to exactly what their image looks like.
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Simply click any of these buttons and every object of that type will be selected! Shift clicking will unselected already selected
objects. This applies in the Viewport too: Shift clicking will select all objects under the cursor and deselect any selected
objects hit. It also wont deselect objects that it didn’t hit that were already selected. Ctrl clicking will bring up a menu letting
you select an object or add it to your selection. Objects in the menu are arranged by distance from the camera.

But back to families. You can give an object a family by selecting it and clicking the [■] button. There are 25 families to
choose from including the default and camera family. Objects in a family will have a coloured outline on the viewport. Then,
you can mass select every member of a family using the Selection Palette in the bottom right.



Other Object Buttons

The [↓] button that appears next to objects will bring
them to the ground of the scene, identical to the Snap
to Ground option on the Align Control. Objects will be
placed on the ground so that no part of them is
underground. If an object is already underground, the
button will look like [↑] instead.

On groups with booleans a [C] button will appear which
converts the group into a single mesh. This makes the
object behave like a rock or imported object, where you
can smoothen it but can’t directly edit it.
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Camera Controls
Bryce has two main cameras, the director camera and the
scene camera. The scene camera shows us as an object in
the viewport (the green pyramid with lines projecting out).
You can move both via the camera controls but only the
scene camera can be moved like an object, and undoing will
only revert changes to the scene camera. The director chair
will let you switch between cameras. Dragging the Island
symbol horizontally will also swap between these cameras
and other orthogonal views.

The three arrows allow you to move the camera. Dragging
near the tip of the arrow will restrict movement to one axis,
while dragging the green circle in the middle will move the
camera on two axis. The big trackball lets you rotate the
camera. By default the director camera rotates around the
whole scene, but by pressing the grey arrow to the bottom
right of the trackball you can change its behaviour to centre
on an object or behave like a tripod. The controls for the
scene camera can not be changed.

The green knob to the top left of the trackball banks the
camera to the left or right. The other knob next to it changes
the FOV.
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Even More Camera Controls

The little grey arrows next to each control also influences the camera.

The menu near the positioning arrows lets you quickly orient the camera to an object or
scene centre, edit properties about the camera, or bring one camera to the other. This
can be especially helpful if you forget to change to the right camera before posing.

Pressing Ctrl or Alt while using these controls also has some unique results. Almost
everything clicked with Alt held down will revert it to its default value. Holding Ctrl or Alt
while dragging the arrows or trackball will restrict movement or rotation to a single axis.

The circle in the top right will zoom out and spin around your scene. By holding Shift
you can slow the spinning down, and moving the mouse while holding Ctrl will zoom
the camera instead of rotating it. This is also accessible by pressing Ctrl-Y, and it
doesn’t change the placement of your cameras.

The little square in the top right is a preview of your current render. Since it is so small,
it renders your scene very quickly and can aid in seeing if a render looks good without
having to wait each time. You can change the rendering type, the camera, and whether
it renders everything, just the sky, or a wireframe. The knobs next to the preview lets
you save camera positions. By pressing one while holding Alt you can remove a saved
camera position, but you can not undo this, so be careful!
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Window Toolbar

The window toolbar also houses some important actions.

The File tab will let you save, load, render, print, and merge
documents. It also lets you change the resolution and frame
rate of your document. The file tab is also where you can
import objects and export positive booleans, trees, and other
objects.

The Edit tab has the usual Copy, Cut, Paste, Select All, Invert
Selection, and software preferences. It also lets you copy and
past materials and matrices (or the position, rotation, and
scale) of objects.

The Objects tab lets you edit materials and attributes. It also
lets you group objects, and it gives you a shortcut to the
Motion Lab and Sky Lab.

Links and Help are both irrelevant to making a render, but
they can lead to helpful resources.

45 Window Toolbar

These menus do a lot more, but the most basic features which
are used a lot are also available via more convenient means
like shortcuts or context menus.



Rendering

The buttons below the camera controls handle rendering. Pressing the centre button will render your
scene. If you stop rendering by pressing escape, the button to the right of the centre will resume. The
two buttons to the left disable textures and enable Fast Preview Mode, which skips some of the
rendering processes. Both buttons can help render an image quicker for previewing purposes.

The drop-down menu lets you change the aliasing (whether the render smooths out pixels),
optimization (renders certain scenes better), light settings (more on next page), and priority (how
much your PC prioritizes rendering). Many of these options are also available in the Render Options
pop-up.

Gamma correction adjusts the colours of the render slightly so they don’t appear washed out or dark
on displays. 48-bit Dithering uses more colours to blend the colours slightly more. It increases render
time a little bit.
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Rendering Continued

Report Render Time will bring up a small pop-up with details about your render, most importantly how long the render took,
and some stats about the rays cast if you’re interested. The time the render took is also displayed in the bottom left corner.
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Perspective Projection and 360 Panoramic Projection control whether the
camera behaves normally or like a 360 degree camera. The Panoramic option
is useful for generating sky boxes.

Object Mask, Distance Mask, and Altitude Mask all change your render to
produce colours based on the presence, distance, or height of selected
objects. If a selected object is covered by an unselected object, only the
visible portion will be included.

Regular Object Distance Altitude Object No Plane



Premium Rendering and Render Options

For most renders, Regular AA will be enough to produce a nice render without any aliasing.
However, Premium AA includes some special settings like Soft Shadows, Blurry Reflections
and Transmissions, True Ambience, and Depth of Field.

In addition, you can change more aspects about Anti-Aliasing and Lighting, though only if you
are using certain AA methods or settings.
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It’s Alive!

Animating in Bryce is fairly simple. At the bottom of the editor is a few animation controls. Select an object and press the plus
button next to the key to add a key frame. Move the little green pill on the timeline above the controls, move the object, and
press the plus button again. If you play the animation from the start, that wireframe object should be moving! Obviously
there’s more to it than that, but most of it is better fit for an Animation Guide, not a Bryce Guide. So this section will just
explain what the controls do.

The plus and minus buttons add and remove key frames for the selected object. To add or remove specific keys (say the
Rotation of an object) or to key the sun, sky, or camera, hold down either button and select the property. If you have no
objects selected, Bryce will automatically control keys for the sky and sun.

The empty slots on the left let you save timeline positions. The usual video control buttons will also let you move through the
timeline and keys. The film reel button will create a tiny preview of your animation. Viewing an animation in the viewport can
sometimes be unreliable since the speed changes depending on the objects in the scene, but the preview animation is more
reliable (but not perfect).

Dragging on the timeline away from the scrubber lets you change the working range. Dark parts of the timeline are not part of
the working range. This doesn’t affect rendering, but the Preview animation button only previews the working range.
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Movement on the Big Screen (and Paths)

Animated objects will show their movement path when selected. Each
key position is represented with a blue dot. You can move these around
to change the position of the object at the key, though you can not
change the time of the key like this.

Bryce has a separate Level of Detail for objects in motion. Auto LOD
may make your objects appear lower quality in the editor while playing
an animation.

Paths are presets of movement keys and positions. They can be created
via the Create Tab’s Object menu or by selecting an object with motion
animated and clicking Objects > Create Path on the window toolbar (or
Alt+P).

To make an object follow a path you need to link them so the path is the
object’s parent. Then move the object around and it will be bound to the
path. Keying the object at different positions on the path wont make the
object move straight from one point to another, but rather the object will
follow the path it’s linked to to reach the keyed position.
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Advanced Motion Lab
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The sine wave button next to the other animation controls takes
you to the Advanced Motion Lab, where you can see the key
frames of selected objects and change how they ease into each
other.

The graph on the left controls the easing of the selected key
timeline (Position, Rotation, etc). To add points to the curve
click anywhere on the graph. Shift clicking a point will change
its easing, and Ctrl clicking will delete it. Note that from the
bottom to the top of the graph is the start and end of the
timelines starting and ending keys. If you add keys, the graph
will not change.

The bottom houses the keys and individual timelines for
separate properties. You can drag to select multiple keys (the
thin white lines), Shift click to add keys to your selection, Ctrl
drag to duplicate keys, and Alt drag to move keys relative to
each other.

You can hide objects in the preview window on the right. You
can also move the camera around and save camera positions.



Setting and Rendering Animations

Before you can render your animation (or ideally before you even start animating) you need to pick your frames per second.
This is done in the Animation Setup. This menu lets you change other properties like the duration of the animation. If you need
to change fps later on, you can pick whether the keys scale to match timing (one second in 15 fps lines up with a second in 30
fps) or if the duration just extends (so one second in 15 fps would only take half a second in 30 fps).
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You also can’t directly input render resolution like when you render an
image, so you need to use the render resolution options in the Document
Setup.

To render an animation, select Render Animation from the File drop-down.
From here you can change how long the animation should go for, where to
save it, and what to export it as.

For the Output Module I highly recommend always using BMP Sequence,
where each frame is exported as an image. It might sound daunting but
render times can be unpredictably long, so if you need to cancel for any
reason you’ll lose one frame of progress instead of all of your progress.

Video editors and software like FFMPEG can compile these frames into a video (see Applications).



Customization

To the right of the viewport is a bunch of settings that only affect the editor and not the render. The first two, cheekily
enough, let you scribble on the editor. No, not just the viewport, the whole editor... and the toolbar... and the taskbar.
The spray can lets you spray in your render. Unfortunately, this is only restricted to the viewport, and it’s prone to
crashing if you drag for too long.

The button with the two black corners lets you expand the editor to fit the whole screen in Bryce 3. The folded button
lets you change the background of the editor to various textures or a colour of your choice. The button below that will
make a small version of the scene appear near the camera controls when moving the camera. The button below that
toggles whether you can drag on a render to re-render a small section.

The button with the line gradient controls how bright objects appear in the viewport depending on how close they are.
Ctrl clicking it disables the depth cue and makes every object the same brightness. The button below it with the A
controls whether objects project a shadow to the ground in the editor. The button below that with the divided rectangle
toggles the ground to be visible. The ground is represented by a green horizon, and object below the line are not shown
in the editor. The button below that with the arrow lets you change the Level of Detail or LOD. This controls how detailed
objects look in the editor based on if they are selected, moving, or neither. Auto LOD will lower the LOD if the scene
gets too laggy.
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Display Modes

The cube below all of those controls the Display Mode, or how the viewport actually looks. Default options let you layer the
wireframe over the render, or simply display one or the other.

But Bryce 7 has other options that show objects in more detail as seen below. Despite textures and meshes looking crude
and skies not being accurate, the objects still react to light. There are other options like Hidden Line and Lit Wireframe which
do not render faces, and Smooth Shaded which does not render materials.
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Just a Bit More...

Here are some extra titbits regarding various other parts of Bryce.

Holding Alt while clicking on the Zoom In, Zoom Out, or Drag controls will reset the camera. Holding Alt while using the Scrub
Time control lets you move the time in your animation without the viewport updating. Alt+Clicking any colour control in Bryce
will bring up a colour slider for more control. The pop-up allows you to swap between a Red Green Blue, Hue Saturation Value,
Hue Lightness Saturation, and Cyan Magenta Yellow slider set.

Holding Alt while adding a terrain will instantly bring up the Terrain Editor. Holding Alt while adding a plane will quickly add a
volumetric slab. Holding the add or remove key button in any lab lets you change specific properties. Bump Height can
actually go from -998 to 998, though anything below -100 or above 100 needs to be manually entered. Ctrl clicking the texture
slots next to material properties will use the properties of multiple textures. Dragging a component to another in the Deep
Texture Editor will duplicate it in that slot.

By copying the matrix of another object and pasting it on the camera you can resize it. This actually changes how it behaves!
The sun’s position can be manually entered in the Sky Lab. An Azimuth value of 0 and Altitude value of 90 makes the sun shine
directly down. Most light and sky properties can be set to a negative number. The Sky Mode can not be animated.
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There’s probably even more secret added controls in other sections like the Material Lab and Sky Lab, so play around with it!
Where there’s a button, there’s probably a cool unique thing that happens when it’s Ctrl, Alt, or Shift clicked.



Wisdom!

Now that the intuitive functions have been covered, it’s time for
fun! Here’s a compilation of tips and tricks I’ve learnt. These
vary from practical solutions to cool tricks to artist advice.
These aren’t the end-all-be-all answers or the best way to do
things, but I think they’re adequate.

And for my first tip, I’d suggest just trying whatever you think
will work! Don’t rush to guides to try and solve issues. Every
roadblock can be a learning experience, and watching a tutorial
can sometimes take the satisfaction of overcoming a problem
away.

Then again, knowing exactly what you want but not knowing
how to make it can be frustrating, so do as you feel. If you’re
interested in 20 factoids about Bryce, continue on!
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All (Dirt) Roads...
With Bryce materials it can be hard to get a path that has blended sides, clear in the middle and grassy on the sides, or
whatever your road predicament may be. This solution is admittedly low tech and not very elegant, but if you turn your path
plane or cube into a terrain you can achieve this blending.

I’d recommend setting the material of the terrain to have the texture Basic Altitude or Fading, since the blending occurs
because the middle of the path is a different height to the sides. Make sure the terrain has some height, even if it’s barely
noticeable, but it can’t be flat.

Set the texture to map to Object Space and scale the Y Frequency. You may need to Offset Y as well. Keep fine tuning
these until the edges of your path and the middle of your path is how you like. It’s tedious but the results are worth it!
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Nobody like a Grass
Like dirt paths, grass can be hard to emulate. There’s a few different paths you could go. If you want to stick with Bryce
one option is creating a noisy terrain and giving it a transparent material with spots. For a more thorough tutorial check out
this tutorial by David Brinnen.

You could just skip the spotty material and make it green. This can look fine for very dense grass or a more retro scene.

If you’re not opposed to using other software, many programs exist out there like Bantam 3D Grass which generate 3D
models of grass, letting you import it as a mesh. Surprising these are less laggy than the terrain solution but they are
much more stylized, depending on the software.
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https://www.youtube.com/watch?v=860i2_tfdtM
https://horo.ch/raytracing/tools/b3dg_en.html


Trees of Variety
For more interesting looking trees, try layering
a smaller one over the main one. Duplicate the
tree, make the trunk an invisible material by
turning on Blend Transparency and setting
transparency to 100. Change the randomness
and the colours and you’ll have something
more unique!

This might not look good for all trees, but
bunched up branches like that of a Palm Tree
can produce very good looking decor.
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Light Decals
If you want to project an image onto a surface, the
most... apt... method I’ve found is to use a square
spotlight. This will make the image wrap over whatever
it’s shown on, but by default it will light up the material
it’s on.

So do this instead. Make the image inverted (via an
image editor or online. If you’re image is black and
white this can be done directly in Bryce 3D) and import
it. Then make the light have a specular value of 0 and a
diffuse value somewhere around -5 to -10 depending
on the desired intensity. Now the image is mapped and
isn’t lighting up the object behind it.

This could also result in decals being darker since they
don’t adopt the ambience of the back object, but with
some tinkering you can get decent results, and multiple
lights will play nice with each other if they’re dark
enough, so you won’t get weird artifacts. This makes it
useful for graffiti and mural art.
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Light Sucker
Negative lights can be useful for other things too,
mainly creating a really abstract scene.

For a great deal of chaos place two lights with
opposite extreme diffuse values and see how they
interact with other objects, bump, and reflections.
You can get really psychedelic renders by
cranking up the diffuse and letting the lights fight!

Negative lights can be used in more subtle ways
too. Since negative lights and specular shines
have a bit of colour and aren’t fully black they can
be good for some subtle effects. The background
render uses a negative specular value to imitate a
blood spill.
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Forbidden Displacement
Chances are your experience with displacement hasn’t been
more than randomizing an objects material, getting a texture in
the displacement slot, and then Bryce crashes. Usually bump
is enough to make a material convincingly uneven so you don’t
use displacement.

But there is a way to use it without Bryce crashing! You need
to set the Render Priority to Low in the Render Options. Any
higher and Bryce will throw a fit.

Granted, the displacement looks very pixelated as you can see
in the render on the right. Additionally rendering the material
takes ages, doubly so because of the low rendering priority.

And honestly, bump is still more useful in most situations...
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Let Clouds Be Clouds
Don’t be afraid to give your clouds wacky textures!

Cumulus and Stratus Clouds are generated from textures
identical to those made in the Deep Texture Editor, though
only the alpha part of the texture is used to generate clouds.
Nevertheless, you can still create great results by using unique
textures. Square and Techno noise can produce surreal
artificial results, while any noise using Auto-phased mode will
look real trippy. You can also make more subtle background
effects like the render to the right which uses low cloud
coverage and amplitude to blend with the sky.

Remember that the colours of clouds can be changed using
the colour picker below the Cloud Coverage control in the
Sky&Fog Tab. Clouds are also influenced by the Ambient
Colour below the Shadow Intensity control.
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Which Way Does the River Flow?
When animating materials like water it’s important to know how
to give the effect of a continuous, natural, and fluid flow. This
might seem like a no-brainer but unnatural water looks very
jarring in most animations. Simply put for a pool or a body of
water with little directional movement it can be enough just to
animated the Y Offset. This makes the water bumps move in a
continuous and smooth manner.

This can work with cloud planes too but you might want to add
some X or Z offset if you want to imply that there’s any wind or
force moving the clouds. Obviously there are times where
animating these materials differently can give a cool stylistic
effect, but if you don’t know how to make your water ripple just
remember that changing the Y Offset only will be good enough.
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Getting Rigged
Bryce doesn’t support armatures or animation bones so
every motion happens on an object basis and not a bone
basis. However, you can still make somewhat of a rig
using Linking.

Create a model where every movable part is its own
object, so hind leg, fore leg, torso, etc. Select all objects
and show their Origin Handle, then position each of them
at the point they should rotate. For arms this would be
near the shoulder, basically where the start of the bone
would be. It’s important to do this now because doing it
after linking will move all connected objects when moving
the origin!

Finally link every object to what their parent should be.
Hand to forearm, forearm to torso, head to neck, you get
the gist. If you want you can also make an invisible root
object and link the highest parent (most likely torso or
waist) to it. And remember that you can rotate objects by
holding Ctrl and dragging their anchors in the viewport.
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Animation without Pain
This may dissuade some beginners, but animating in Bryce is a pain. Most
quality-of-life features present in modern animators are simply absent, and what
we do have isn’t the best.

It’s best to block out all of your animations first. Just the simple linear movements,
start and end position and their times. This is because the motion graph updates
when you add new keys past the last one, which misaligns everything. First get all
of your keys, then change the easing.

I’d say always use the Preview Animation button because pressing play in the
viewport can be inaccurate because of lag. However I’ve found that Preview
Animation itself can also be inconsistent! For perfect accuracy just render the
animation in really low quality and build using FFMPEG or your preferred editor. If
you need an even quicker preview, holding shift while clicking the green check
mark on the Render Animation menu will output a fully sized wireframe video.

And finally, Save! Save! Save! Always have a version of your scene with no
animations in case you need to change stuff up, because without it you need to
manually delete every key. This is again a tip for more complex animations but it’s
saved me headaches (not that I didn’t get any).
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Looking Fish-Eyed
You can achieve a fish-eye lens or pincushion effect where the world seems like it’s
bulging out or pinching in. This is done by placing a lens object really close in front
of the camera.

First create the lens. Yes, a literal lens, as the shape is integral for the effect. First
create a sphere, then create another sphere, and then a cube. If you don’t transform
them they should all be in the same spot. Make the cube skinnier from one of its
sides and shrink one of the spheres by a bit. The cube should be as tall and wide as
the sphere and about half as long. Then make the small sphere and cube negative,
the bigger sphere positive, and group them. This is now a lens object!

For the material I find full transparency, no other property more than zero, and a
refraction of about 250 gives a good bulge. Feel free to tweak the refraction for
cooler effects.

To actually place the lens on the camera set both of their positions to all zeros.
Rotate the lens so the bulge and camera are looking the same way, then link the lens
to the camera, and finally make the lens really small so you don’t see it in reflections.
Now you can move it around or set it back to one of your camera presets.
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The background uses a stretched out lens and some Atmospheric
materials to create a warped hyperspace effect!



Lens Magic
Using the lens object you can create many other effects.
Glasses which have no colour will mainly warp the perspective,
but other transparent materials can produce cool results.

Glasses in the Pro Materials section like Rainbow Glass and
Soap Bubble leave a rainbow spill over everything. Coloured
transparent materials like those in Glass > Colour can give
everything a tint.

Waters can also cause distortion. In fact, pretty much every
material will look unique if made transparent. Do keep in mind
that the lens is really small so materials using World Space
mapped textures may look off. Render times may also become
longer since all of the rays need to pass through the glass first.
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The top half of the render uses the material Ocean Foam found in
Atmospherics > Clouds-Surface. The Additive setting on the
material was toggled so the lens would lighten up the scene.
The bottom half uses a glass material coloured purple.



Ingredients for The Bryce Render

If you want to use parts of the Bryce editor in your render then by all means screenshot elements
you like and include them! Since the style is associated with Bryce, having some UI element or
tab present can be fitting. However you might also want to create your own elements mimicking
Bryce UI.

The font Bryce uses is variations of Helvetica Neue, bold for headers and regular or thin for body
text. The colour used is white for headers and grey with a value of 43. The blue tabs in Bryce 3
use a font similar to Hauslan.

If you want to use the Bryce editor in your art then you must use Bryce 3 since Bryce 7 Pro
doesn’t let you resize the window. The viewport has a top margin of 80 px, bottom margin of 38
px, left margin of 140 px, and right margin of 20 px. This means for an image with a set width and
height, the size you should set the document in Bryce 3 should be 160 px slimmer and 118 px
shorter. However, the document can only be 480 px wide and 360 px tall minimum. Any less
won’t resize the editor.

Since most of the icons are really small, don’t worry about giving them a lot of detail. Though
make sure that icons are scaled down so they become blurry, as this lines up with what the object
buttons look like.
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Defining (or Desecrating) the Style
Bryce is good at making realistic scenery, foliage, terrain and
environments. It’s also good at making retro surreal nonsensical
unrealistic worlds. Often it can be helpful identifying which of
these you want your render to be apart of. This can guide creative
decisions, like should you use a dirty mirror or a completely
reflective material? Is a simple green good for the ground or
should it have grass? Would this be realistic in my world?

But even more can come out of betraying these guidelines to
create juxtaposition. A broken down vine infested car amidst
flying primitives, or a super detailed lab protecting a shiny perfect
primitive. This can influence other decisions like whether to anti-
alias your render and what resolution to render it. A consistent
style makes an appealing render but a clashing style can create
an interesting render.
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Switcheroo
If you feel that your render is bland or if you’ve lost interest in the original concept, try changing things up! Try new camera
angles, different materials. Change the mood into something different. An all time favourite tactic for me is to select
everything and give it the Mirror material. Pretty derivative but it’s still satisfying seeing all of the reflections mingle with each
other. If mirrors aren’t your thing you could also try the super negative lights mentioned previously.

In fact, any light source can really change a scene, especially one that doesn’t already have any lights. Another more
destructive one is making every object the same. Admittedly you’re probably not gonna get a good render out of this one,
but it can still be a neat experiment. Never feel that a render is stuck the way it is. There’s always something you can do,
drastic or minute, that can give your scene a brand new feel.
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Trust the Process!
Sometimes while making a render your mind might
go “yep, this is crap, I give up.” Trust me, if your
idea is good, the render will eventually pan out.

Most renders that I’m really proud of eventually
made me go through the “I give up” mindset, but
sticking through it lets the idea be realized. Other
renders are now lost to time because I never
recovered from the “I give up” mindset, like the
one in the background which I revisited while
writing this. All of these started out the same way
and hit the same roadblock but only those
completed were ones where I stuck with it and
watched it become real.

Every changed material, every light meticulously
added, is a small but crucial part of a greater
piece.
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Let Yourself be Inspired
These last few are a lot more subjective and are stuff I’ve learned that have worked well for me, so don’t take this as gospel!

Don’t feel like every idea for a cool render has to be created within your mind all by yourself. Get inspired by stuff! Try making
a render based on your favourite music, or even your favourite genre. Imagine “if this was a picture, what would it look like?”

Your surroundings can also be great inspiration. See some cool architecture somewhere? Why not try recreating it! Or even
better, try turning it into something completely unique but still recognizable. This isn’t just limited to architecture too. Nature,
artwork, people, food, anything!

Also don’t be afraid to let your emotions bleed into your work. If you feel angry or upset, or really excited, let it show! You
don’t need to make every render completely neutral (if that’s something you even do, it’s a bit weird to imagine art separated
from emotions). Not every render needs to have a complex story or a story at all, but don’t hesitate to add one if you want to!
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Hobbyism
Treat making renders like a hobby and not like a chore. That might
sound obvious but it’s something we all forget. Until that render
escapes your hard drive it should only provide you with happiness.

This point is tied with posting your art on social media. Eventually you
can develop a quota you feel you need to reach, surely intertwined
with the quantitative value social media gives your art. Trust me, your
followers aren’t going to care if you don’t post on a regular schedule.
If you want to grow your account then by all means, but when you get
to a point where you’re creating posts and not art you stunt your
appreciation of something special. Again, this is speaking from
experience. Of course there’s people who post on strict deadlines
and still enjoy their work. You may even be one of them! But for a
beginner like I once was, forcing your art to abide by a regime isn’t
beneficial.

But back to the whole hobby thing. If you really don’t feel like
rendering, don’t! News of the world, I know. But eventually as you
build skill you also build attachment. Sometimes when I’m upset I like
to render because I enjoy doing it. Ultimately 3D rendering can be
way more than just a means to create an image.
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Don’t Worry about the Numbers!Don’t Worry about the Numbers!
This is a pretty old-head take but I think it holds. The
numbers next to your renders mean nothing!

Don’t think that the amount of likes your render has is in any
way related to the quality! Good renders get a good amount
of likes but they do so because of so many more factors than
just quality. Your “worst” works are just the ones the least
people have seen, or the ones that didn’t provoke the
random chance of people liking it. And I mean post-liking,
not appreciating.

Once you value these scores that are assigned to your art
you try to one-up yourself, and even if you end up making a
better render you may not necessarily see that if it scores
lower. The only thing that should be determining the quality
of a piece is you, and the only thing that should dictate if you
are improving is your art!

So please, don’t stress over the little number. It isn’t worth it.
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See It Through
It takes time for anyone to get good at anything. That’s just how skills develop. You start at a point and with progress you’ll
get better. Nobody wants to hear that they need to wait years to become good, but eventually you’ll get into good habits
with your desired skill, or in the case of rendering, you’ll know how to create your vision. It can be frustrating to have a
good idea but lack the knowledge to execute it.

Reading this guide (which you may or may not have done) isn’t going to turn you into a master in minutes. No guide can.
You just have to stick with it. It takes patience but what you get out of it is worth it. In the meantime, keep rendering,
making art, or doing whatever you want to get good at. Every render is a step forward towards building a skill!
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This render was made using the tutorial on robinwood.com about Half Submerged Renders (see More Resources)



Applications

This section will be partially about programs useful for
creating pictures and partially about use cases for Bryce
renders. Think of it like the Computer Applications and
Artistic Applications. While those two seem pretty distinct
there is a bit of overlap, and you’ll likely need other
applications if you want more than just a cool render.

Many programs exist that lets you make cool 3D meshes
as easily as Bryce will let you render them. If you’re not
too fond of Bryce, there are plenty of alternative 3D
modellers and renderers which can output similar looking
images.
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Bantam3D Grass
This was mentioned as one of the
solutions to getting grass in your scene.
It’s a quaint little program but it is
effective and highly customizable too.
You can change the angle, width, detail,
and clumping of the grass, plus you can
add rocks too! Given its versatility,
Bantam3D Grass can be useful for other
greenery like seaweed. It can be
downloaded here, and an archive of the
Bantam3D website can be found here.
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https://horo.ch/raytracing/tools/zip/Bantam3DGrass7.zip
https://web.archive.org/web/20040206234140/http://bantam3d.com/grass/index.htm


Arbaro
Another old but gold nature mesh
generator. Arbaro is similar to
Bantam3D Grass in that it is
deeply customizable and capable
of producing wonderfully old but
effective meshes. The properties
of the tree are highly
customizable, so much so that
you can even create cool sci-fi or
surreal plants, and every property
is explained using a diagram so
you understand the true effect of
every parameter. The output
resolution can be a bit low, but
they can always be smoothened
using 3D modellers like Blender.
It can be downloaded here.
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https://arbaro.sourceforge.net/


Ivy Generator
And to top off the old nature mesh creators is Ivy
Generator, a program that lets you import meshes
and wrap them in vines and ivy. You can control the
ivy’s growth rate and path via weights. Once you
have vines you like you can birth ivy onto it. It’s an
incredible tool to create overgrown structures and
areas trimmed in nature. Sometimes meshes
imported can be a bit buggy but triangulating the
mesh before importing it should work fine. It can be
found here alongside examples of it being used.
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https://graphics.uni-konstanz.de/~luft/ivy_generator/


Structure Synth
For less natural but still pleasing shapes there are
many programs that can generate abstract
meshes, one of which being Structure Synth. It
defines its meshes using scripting and iterations.
There are some example and tutorial scripts for
you to learn from. The idea of coding meshes
might seem daunting, but the capabilities of the
software are definitely worth it. It can be
downloaded here and a reference for scripting can
be found here.
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https://structuresynth.sourceforge.net/
https://structuresynth.sourceforge.net/reference.php


Mandelbulb 3D
Another great abstract primitive generator is Mandelbulb
3D. Those familiar with fractals will recognise the
“Mandel” in the name, since Mandelbulb 3D is a 3D
fractal generator! You don’t really need to know what a
fractal is to use the software, but just know that fractals
are defined by complex functions and whether they
diverge to infinity or not at a given point.

You can define your mesh in the Formulas tab and then
render it using the Calculate 3D button. To export
meshes click the “BTracer2” button, then Import
Parameter from Main. Since fractals are so detailed — as
in infinitely detailed — the exported mesh will be a low
resolution portion of the fractal. You can change how
much of the fractal is exported and how defined it is in
the Bulb Tracer2 exporter.

Mandelbulb 3D can be downloaded here.
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https://www.mandelbulb.com/2014/mandelbulb-3d-mb3d-fractal-rendering-software/


FFMPEG
If you choose to render your animation as a series of frames instead
of a video file you’ll need a way to convert those frames into a video.
Most video editors can do this natively, but if your video editor
doesn’t support it or you want a stand-alone solution, look no further
than FFMPEG.

To use it you’ll need to use your command console. Navigate to the
folder with all of your frames using cd [path to frames], then type
the location of ffmpeg.exe followed by your command. So if you
want to render an animation using 30 fps frames in BMP format, with
Bryce numbering your frames “anim0000”, “anim0001”, and so on,
your command will look like this:

[path to ffmpeg] -framerate 30 -i anim%04d.bmp -c:v
libx264 -pix_fmt yuv420p output.mp4

With the other parameters controlling the codec of the video.
There’s a crazy amount of customization and equally in-depth
documentation. Downloads and documentation can be found here.
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https://ffmpeg.org/


paint.net
Paint.net (or Paint Dot Net) is a half MS Paint
successor, half genuine image editor. If you are
proficient in Photoshop or a different commercial
editor, then you’re not missing anything by just
sticking with what you know. But paint.net is capable
of doing a lot of complex things while still remaining
beginner friendly, ranging from basic colour changing
and curves to distortion and blur effects. A particularly
powerful addition to paint.net is this plugin which
contains a series of even more effects. You can really
do a lot with these tools.

Paint.net can be downloaded here. You can find
plugins in the paint.net forums.
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https://forums.paint.net/BoltBaitPluginPack
https://www.getpaint.net/
https://forums.getpaint.net/forum/7-plugins-publishing-only/
https://forums.getpaint.net/forum/7-plugins-publishing-only/


Blender
Of course there are other 3D renderers that can do what
Bryce can. One such is Blender. Comparing Bryce to Blender
is like comparing a bike to a car; you’ll get to your destination
either way but one is much easier to work while the other lets
you do a whole lot more.

Poor analogy aside, there are plenty of tutorials on how to
achieve a retro 3D look in Blender, such as this one by
SunnyIsOnline. This video is great for getting optimal output
settings and lighting, but one of the more important things it
mentions is the Non-Principled BSDF which gives objects a
very smooth and retro look.

There are many other tutorials on how to achieve a retro
looking render. And if you don’t want a retro render, then
Blender excels at pretty much every other style of rendering
too. There’s quite a steep learning curve but simple stuff like
making your own meshes is real simple. Blender can be
downloaded here.
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https://www.youtube.com/watch?v=E8A8jwE_AB0
https://www.youtube.com/watch?v=E8A8jwE_AB0
https://github.com/Render96/Render96Wiki/wiki/How-to-Achieve-90s-Render-look-in-Blender-2.8
https://www.blender.org/download/


POV-Ray
POV-Ray is a program that is relatively similar to Bryce in terms of what it can make, so much so that
they’re usually mentioned together when talking about old cgi. Like Structure Synth, POV-Ray is entirely
controlled by scripting, and is similarly not too confusing and very well documented. Despite this
seemingly primitive work flow POV-Ray is capable of quite a lot, and some of the best renders made in the
software can be found on the software’s Hall of Fame. Like Blender, POV-Ray is harder to learn but you
get a lot of freedom in return, and because of its old age and popularity you can find a lot of tutorials and
resources to help you get started. It can be downloaded here and its documentation here.
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The renders below are POV-Ray demo scenes “Biscuits” and “GlassChess.”

https://hof.povray.org/
https://www.povray.org/documentation/
https://www.povray.org/download/


Terragen, Vue, and More
For even more control in your renders there
are other modern options that can produce
incredible renders, with Terragen and Vue
being prime examples. Both are, as you should
expect by now, harder and more capable than
Bryce. Both are capable of creating hyper
realistic landscapes and scenes, but simpler
Bryce-adjacent renders are still possible.
Terragen’s free version can be downloaded
here and Vue can be downloaded here.

Keep in mind that practically any 3D renderer
can achieve a Bryce look with enough fiddling
around, so you’re by no means restricted in
what software you can use.
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The render on the right is “Stacked
Glass” by Zer0 Rei made using Terragen.

https://www.bentley.com/software/e-on-software-downloads/
https://planetside.co.uk/downloads/permanent/latest/tg/latest-release.php


Exploring Mediums

So you have the skills to use Bryce 3D and
you have access to a bunch of extra tools.
You’re capable of making whatever your
mind can brew up. But what exactly is that?

Images alone are extremely versatile, so
asking what you can make with Bryce is like
asking what you can make with words; pretty
much anything! Animations, Game Art, Music
Covers, Advertising, Posters, and much much
more. The next few pages contain
explanations into some of these mediums as
well as examples of art made in said
mediums.
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“Reality Check 3” by André.

https://www.instagram.com/enigmaworld_org/
https://www.instagram.com/enigmaworld_org/


Animation
Despite the limitations that animating in Bryce brings it is still capable of a lot
of different animations, whether simple background loops or fully fledged
cartoons. Using tricks like the custom rig or changing easing last will let you
produce very appealing animations. It’s just a matter of drive, patience, and
perseverance.

Remember that only the Perspective Camera can be animated and not the
Director Camera. I’d also suggest rendering your animation as BMP frames
and compiling with FFMPEG or a video editor. Also speaking from experience,
try to start small. Humans and organics are a lot harder to make with primitives
than, for example, robots or abstract creatures. Using a less realistic character
can let you excuse the blocky nature of the rigs, but if you do want a human
keep in mind that the custom rig requires every movable part to be its own
object.

To get an idea about what is possible with Bryce, try finding animations online.
It’s impressive how much can be done with such simple controls!

89 Exploring Mediums

“Abstract Factory” by myself. In the actual video the water and some of the glass is
animated. It’s much closer to the low end of animation capabilities.



Game Art
Games like Myst use pre-rendered images for scenes instead of
rendering the scene in real time. This technique was also used in
a lot of other games like Resident Evil and Final Fantasy VII. This
pre-rendered approach to game art is perfect for Bryce since all
you need are images or videos. Then you would layer other parts
of your game over them.

An example of this in practice is Kenopsia, a game which uses
pre-rendered Bryce scenes under moving 3D objects in engine,
combining into one coherent scene. Point and Click games
focusing on one camera angle at a time makes them great
candidates for pre-rendered backgrounds. If you’d like to see
more examples @kenopsia.game on Instagram and their game,
which features beautiful and immersive renders (and even
rendered animations!).

If you’re not interested in Point and Click games, you can still use
renders for background elements suited for various genres
including Visual Novels, Puzzle Games, and many more.
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Both renders are from the game Kenopsia by Jamie Norton,
a point-and-click game set in an abandoned MMO. In
game, these renders are animated too!

https://www.instagram.com/kenopsia.game/
https://www.instagram.com/kenopsia.game/


In the Document Setup there are many presets for conventional print sizes and
rations. Additionally, rendering to disk lets you change the print resolution and
the output size in inches. These are both great for converting your Bryce renders
to physical prints, bringing your digital art into the real world!

Having such specific and customizable settings lets you create more than just
printed renders to display. You could put your art on anything! Clothing, textiles,
covers, and all sorts of decoration. An example of a cassette tape using a Bryce
design is Zer0 Rei’s cassette “呼吸,” which uses a render both for the cover and
the casing itself.

Since Bryce art is inherently appealing — it’s a mix of nostalgia and general
cleanliness — they can make great covers and can give a product a strong
identity, and if your work is good enough then you could see people in public
rocking a Bryce tee or bringing a cassette of yours home!
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Top is Zer0 Rei’s own framed work. Looks even better in real life!
Bottom is Zer0 Rei’s “呼吸.”

Posters and Physical Media

https://www.instagram.com/zer0rei_/


These can be great for displaying but you could argue
there’s even more possible by using renders for other
things like advertising. I mean, why not? They are images
after all. But why stop at advertising? If you treat renders
like an image in a greater design instead of a finished
design itself, you can make whatever you like!

For some general tips, remember that the Object Mask
lets you render an alpha mask of your objects, and make
sure that you’re rendering at a large enough size to keep
the design coherent. The possibilities are endless, so go
wild!
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“icbwiao” by Nakavelli. Bryce art combined with other elements
can produce fantastic digital designs like this.

Designing Renders

https://www.instagram.com/nakavelli/


General Art
Of course, your renders do not have to be the
means to a greater design or a prop in a bigger
project. Bryce alone can be a tool for creating
art too!
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On the left is “Comfort” by Max Cahoon.
Above is “The Ritual” by Luke Hamerton.

Don’t be afraid to try wacky or surreal ideas! Whatever you
can think of, Bryce can handle it.

https://www.instagram.com/floatingorb_maxc/
https://www.instagram.com/lh_art0/


More Art
The renders on the top left is a piece by PyrMoboid.
The render in the bottom left corner is “Maximalist” by Max Cahoon.
To the right of them is “The Moment Between You and the Sound” by André.

https://www.instagram.com/pyrmoboid/
https://www.instagram.com/floatingorb_maxc/
https://www.instagram.com/enigmaworld_org/
https://www.instagram.com/enigmaworld_org/


Aesthetic Freedom
Bryce isn’t really limiting in terms of style. Though most people associate it
with old school cgi, it is far more capable than that. You can use HDRIs, ultra
bright colours, custom made meshes and every other tool in your arsenal to
create renders in any style. And I iterate yet again, renders are just images.
Images can be used for millions of things, so don’t feel restricted to render a
certain aesthetic or create a certain type of design. Bryce becomes a lot more
powerful when you see it as a 3D renderer and not an old cgi renderer, and
that goes for every 3D modeller mentioned.

Various things like render resolution, anti-aliasing, mesh smoothing, the detail
of your meshes, and which materials you use all play a large role in setting the
style. If you want to keep the old cgi look then by all means, make the art you
wanna make!
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On top is a piece by Shawtythepimp. Below that is “Seismic Thirst” by Fiona Skye.
Even though they both use Bryce they have very distinct looks and identities. The
limiting factor is not the software you use but how you choose to use it!

https://www.instagram.com/ephemeral_dimensions/
https://www.instagram.com/shawtythepimp/
https://www.instagram.com/shawtythepimp/


The Appeal
But why do people love the retro look? Well, I believe there are a couple
of reasons, one of the main ones being nostalgia. Most people have at
some time witnessed art that looks like the retro art made using Bryce. It
unlocks memories past! Whether it was an old game with smooth but
primitive graphics or a wacky image on the back of your Trapper Keeper,
you’ve seen it before.

Another reason may be somewhat of a technological appeal. In a time
where computers can produce something that could convince one it was
real — with or without AI, mind you — it’s good to see something blatantly
old and computer-crafted. Also, as mentioned at the beginning of this
book, the style of Bryce is too good to be ugly. Obviously it is possible to
make something unpleasing with it, but the art style allows more things —
things that a realistic render would prohibit — to slide.

The “Bryce Art Style” or “Retro Aesthetic” or “Y2K Graphic Style” or
whatever you want to call it will always look good and nostalgic unless
the artist has purposely worked against that.
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A render by Richard Tempest The use of old cgi-
styled graphics in their game Disillusion ST gives it a
striking personality.

https://www.instagram.com/life.seeker_dst/
https://store.steampowered.com/app/2775370/Disillusion_ST/
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Meet the Artists

The previous section featured fantastic art showcasing the various applications mentioned. Thank you to the artists that very
kindly let me use their work as examples! Go check out their other work!
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André
@enigmaworld_org

Jamie Norton
@kenopsia.game

https://www.instagram.com/enigmaworld_org/
https://www.instagram.com/kenopsia.game/
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Nakavelli
@nakavelli

Max Cahoon
@floatingorb_maxc

Meet the Artists

https://www.instagram.com/nakavelli/
https://www.instagram.com/floatingorb_maxc/
https://www.instagram.com/floatingorb_maxc/
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Luke Hamerton
@lh_art0

PyrMoboid
@pyrmoboid

Meet the Artists

https://www.instagram.com/lh_art0/
https://www.instagram.com/pyrmoboid/
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STP TV
@shawtythepimp

Fiona Skye
@ephemeral_dimensions

Meet the Artists

https://www.instagram.com/shawtythepimp/
https://www.instagram.com/ephemeral_dimensions/
https://www.instagram.com/ephemeral_dimensions/
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Richard Tempest
@life.seeker_dst

Zer0 Rei
@zer0rei_

Meet the Artists

Zer0 Rei also helped with proof-reading and provided feedback
on the book, as well as provided info for the Posters and Physical
Media page!

https://www.instagram.com/life.seeker_dst/
https://www.instagram.com/life.seeker_dst/
https://www.instagram.com/zer0rei_/
https://www.instagram.com/zer0rei_/
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Super Render 64 DD
@superrender64dd

Meet the Arthour

I’m the author of this guide and I occasionally make
renders too! This book was something that kept lingering
at the back of my mind since I really wasn’t happy with
how I left the old version. Cringing at an obvious error I
remembered writing gave me motivation to create this
revision. Hopefully this version serves its purpose better
than the last one.

I’m not going to tell you to follow me. However, I do ask
that you share either this PDF or a link to the website to
anyone who wants to learn or currently uses Bryce. I
know expecting anyone to read a hundred pages on a
basic 3D renderer is ludicrous but many of the hidden
functions mentioned are genuinely useful. Of course, you
don’t have to share this, but at least do this.

Keep creating, keep making art and sharpening your skill
sets, and never let anything or anyone stop you from
doing what you love!

https://www.instagram.com/superrender64dd/
https://www.instagram.com/superrender64dd/
https://sr64dd.github.io/index.html


More Resources

Most of the generator programs mentioned were found on a blog by Horo, which features many other tools as wells as
documentations for Bryce 3D, as well as other 3D goodies. There are many more tools listed on his blog so check it out if
you’re interested. POV-Ray’s website also have a multitude of different programs for various applications in their Resources:
Links section.

If you’re looking for more Bryce tutorials, here are some great resources:
• David Brinnen on YouTube. He has a ton of tutorials of varying skill level. The beginner videos explain concepts in a very

understandable manner, and the expert videos are complex but thorough.
• Bryce Discussion Forums. The forum is frequented by experts of the program and many threads are useful as references

and guides. This discussion links to a bunch of useful threads.
• bryce-tutorials.info is a website that has a lot of free and paid assets. In addition, its tutorial section is basically a

compilation of hundreds of tutorials from various people.
• robinwood.com also has useful beginner and intermediate tutorials revolving around different parts of Bryce. Their courses

explain how to create stunning effects like the half submerged render which I used for the page “See it Through.”

If you are looking for more inspiration you’ll find that Bryce content can be found pretty much anywhere. All artists featured in
this book including myself publish our works to Instagram and plenty of other people do the same. If you particularly want
animations, searching “Bryce 3D animation” on YouTube will bring up heaps of animations. Inspiration is out there, you just
have to find it!
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https://horo.ch/raytracing/tools/intro_en.html
https://www.povray.org/resources/links/
https://www.povray.org/resources/links/
https://www.youtube.com/@davidbrinnen
https://www.youtube.com/@davidbrinnen
https://www.daz3d.com/forums/categories/bryce-discussion
https://www.daz3d.com/forums/discussion/47426/links-to-useful-threads
https://www.bryce-tutorials.info/bryce-tutorials/
http://www.robinwood.com/Catalog/Technical/BryceTuts/BrycePages/BryceWhy.html
http://www.robinwood.com/Catalog/Technical/BryceTuts/BryceClasses/IBryce5/IBryceLesson5-5.html


Closing Remarks

Hopefully now you are well versed with the Bryce program, or
have learnt a new way to make your scene great, or appreciated

the possibilities that the software provides.

Remember that getting skilled at something takes time. I hope
this book has helped you become more proficient, but you can

always become better. We all can.

And with that is the end of the book! So go and make that idea
that’s been brewing in your head a reality. Get creating!

Thank you for reading!


